User’s Manual

Welding Data Transfer Software

Hürner DataTrans for PocketPC

HÜRNER SCHWEISSTECHNIK GmbH
Nieder-Ohmener Str.
D - 35325 Mücke
Tel. +49 (0)6401 91 27 0
Fax +49 (0)6401 91 27 39
E-Mail info@huerner-st.de
Web http://www.huerner-st.de

Version September 2005
## Contents

1 Introduction .......................................................................................................... 5
2 Starting up the PocketPC and Preparing to Install DataTrans.................................... 5
   2.1 Verifying Shipped Parts and Starting up the PocketPC........................................ 5
2.2 Installing the Microsoft ActiveSync Utility ............................................................. 6
2.3 Setting up a Partnership....................................................................................... 7
3 Installing Hürner DataTrans .................................................................................. 8
   3.1 Installing the Software .......................................................................................... 8
   3.2 Starting DataTrans ............................................................................................... 9
   3.3 Entering License Information ............................................................................... 9
   3.4 Input Tools of the PocketPC ................................................................................. 9
4 Loading the Welding Reports from a Welding System................................................. 9
   4.1 Transfer via a Serial Interface ............................................................................. 10
   4.2 Transfer via a Bluetooth Interface ..................................................................... 10
5 Viewing Welding Reports on the PocketPC........................................................ 11
6 Transferring Welding Reports to DataWork GIS..................................................... 11
   6.1 Setting the Correct Connection Parameters....................................................... 11
   6.2 Selecting in DataTrans the Data to Be Transferred............................................. 12
   6.3 Starting the Transfer in DataWork and Finishing off the Transfer Operation...... 13
   6.4 Direct Import from the PocketPC into DataWork GIS........................................ 13
   6.5 Deleting Reports in the PocketPC with DataWork GIS ..................................... 14
   6.6 Restoring Reports Backed up on the SD Memory Card .................................... 14
7 Customizing DataTrans to Your Preferences ...................................................... 14
   7.1 Display Language ............................................................................................. 14
   7.2 Program Version Information .......................................................................... 14
   7.3 Manufacturer Company ................................................................................... 14
8 System Requirements ........................................................................................ 14
9 After-sales Service Contact Details ..................................................................... 15
9 Shipped Parts ...................................................................................................... 15
1 Introduction

Dear Customer:

Thank you very much for purchasing our product. We are confident that it will meet your expectations.

Hürner DataTrans is your tool for reading welding report data from all Hürner Welding Systems with report capabilities, saving them on the optionally available PocketPC with the Microsoft Windows CE/Mobile operating system, and transferring the data to your desktop or laptop computer with Hürner's Welding Data Management Software DataWork GIS.

Available interfaces between the devices are USB, serial and Bluetooth.

Thank you.

2 Starting up the PocketPC and Preparing to Install DataTrans

If your shipment includes the optional PocketPC (called also PDA – i.e., Personal Digital Assistant – by some manufacturers), Hürner's Data Transfer Software DataTrans is not installed when the device arrives. In order to ensure properly working data transfer to and from your desktop or laptop computer, it is preferable to install it from your computer onto the PocketPC.

To be able to install programs onto the PocketPC from your computer and to perform data transfer actions from DataTrans to DataWork GIS, Microsoft's ActiveSync utility program for data synchronization has to be present on your computer. In case the utility program is not installed on your computer, you will have to install it before using DataTrans.

2.1 Verifying Shipped Parts and Starting up the PocketPC

Depending on the manufacturer of the PocketPC, the parts that are actually shipped may not be the same in all cases. If your order includes a PocketPC, Hürner will ship it as shipped by the manufacturer, with the original parts and in the original wrapping. Use the manufacturer's original documentation to check if you have received everything.

In most cases, a PocketPC is shipped with the following parts:
- PocketPC in an anti-electrostatic jacket, possibly with a storage pocket for the PocketPC
- Cradle for docking the device to its charger and power supply and data transfer cable (USB)
- Power supply and power supply cord
- Utilities and further software from the PocketPC manufacturer
- Rechargeable battery for the PocketPC

Additionally, Hürner Schweisstechnik will ship the following parts:
- DataTrans installation CD Rom
- Depending on your order, Parallel/Serial adapter and/or Parallel/Bluetooth adapter for loading data from a welding system
- Serial data transfer cable
- Secure Digital memory card

First, start up the PocketPC according to the manufacturer's documentation. Depending on the make, start-up may be performed in various ways.
In most cases, however, it will include the following steps:

- Remove the protective film from the screen of the PocketPC
- Install the battery in the PocketPC
- Connect the PocketPC to the power supply and charge its battery

**Important**

Start by charging the battery to full load, according to the manufacturer's documentation, before using the PocketPC for the first time. Most manufacturers warrant proper data transfer operation only when the battery was fully charged immediately at start-up and before any further use.

With some makes, you will be required to reset the PocketPC at start-up. If the manufacturer's documentation asks you to perform a reset, do so as indicated in the documentation. In most cases, you will be asked to use a dedicated reset switch.

When you start up or have reset the device, the operating system Windows CE/Mobile will walk you through an initialization routine. Follow the indications given on the screen of your PocketPC. By doing so, you also adjust the PocketPC to your personal way of handling the pointing stylus and you get familiar with some of the features of the device.

Do not connect the PocketPC to your desktop or laptop computer yet if Microsoft ActiveSync is not installed yet on your computer.

### 2.2 Installing the Microsoft ActiveSync Utility

If Microsoft ActiveSync is already installed on your desktop or laptop computer, skip this section and go to the next.

If Microsoft’s ActiveSync utility program for data synchronization between PocketPC and desktop or laptop computer is not installed on your computer, you will have to install it at this point. Ensure that the connection between the PocketPC or its cradle and the desktop or laptop is not established before you are asked to connect them to each other during the ActiveSync installation.

To install Microsoft ActiveSync, you need so-called administrator privileges, i.e., full access to all system parts of your computer. This may not be the case if you use a computer that is part of a corporate network. If you have not set up your computer yourself, when in doubt, ask the person in charge of networking within your organization.

In most cases, Microsoft ActiveSync is shipped on the utility software CD Rom enclosed by the PocketPC manufacturer. Furthermore, a German-language, an English-language, and a French-language version is shipped on the DataTrans CD Rom. If you want to install the utility from the DataTrans CD Rom, click **Start** on your Windows desktop and then click **Run**. In the dialog box that opens, use the “Browse” button and locate your CD Rom drive (e.g., D:\) and on the CD Rom, the folder ACTIVESYNC. You will find the installation file for the German-language version in the sub-folder ACTIVESYNC_DEU, the one for the English-language version in the sub-folder ACTIVESYNC ENG, and the one for the French-language version in the sub-folder ACTIVESYNC_FRA.

Select the desired installation file, click “Open” and then “Ok.” This launches the installation wizard which will guide you through the installation step by step.

Follow the indications given on the screen. When you are asked to do so, connect the PocketPC, or, if inserted into its cradle, the cradle, to
your desktop or laptop computer using the data transfer cable (USB or serial). When you have established the connection between the PocketPC and your computer, the installation is being completed. This is recognizable from the opening Microsoft ActiveSync main window (see Display 1). The window will first indicate that a connection to a mobile device is being searched, then that a device was detected and that a connection was established. Also, the task bar in the lower right-hand corner of your screen will show the green ActiveSync icon, next to the time of day and the loudspeaker icon for setting your computer's volume (see Display 2). When Microsoft ActiveSync is enabled but does not detect a mobile device to connect to, the icon will be light grey, not green.

If during the installation you are asked to restart your computer in order to complete the installation, do so when asked to.

### 2.3 Setting up a Partnership

While the installation of Microsoft ActiveSync is being completed, you are asked which kind of partnership (i.e., data transfer connection) should be set up for your PocketPC and desktop/laptop computer: standard partnership or guest partnership.

If you intend to use your PocketPC for purposes beyond its welding data transfer and external memory unit capabilities, for instance to constantly keep appointments, contacts, etc. up to date on both your computer (desktop or laptop) and your PocketPC, then you should select the “Standard Partnership” option. This will allow your computer to recognize the PocketPC every time it will be connected to it in the future and to synchronize appointment, contact, and other data automatically between the PocketPC and your computer.

If you just want to transfer data back and forth between the PocketPC and your computer, then the “Guest Partnership” option is sufficient. In this case, your computer will not recognize the PocketPC the next time it is connected, and it will ask you again which kind of partnership you want to set up. Note that in this case, data synchronization (appointments and the like are compared between both devices and kept up to date in both) will not be possible.

The dialog boxes in Displays 4 and 5 will only pop up if you selected the Standard Partnership with data synchronization capability. To specify how synchronization should occur (Display 4), select “Synchronize with this desktop computer.” The
second option allows synchronizing an entire network via a Microsoft Exchange server, but DataTrans is not intended for this.

Finally, specify which data (contacts, appointments, and the like) you want to synchronize between the PocketPC and your computer. Please note that synchronization without problems can only be guaranteed if Microsoft Outlook, version 2002 or higher is running on your computer.

3 Installing Hürner DataTrans

3.1 Installing the Software

To install DataTrans, insert the installation CD Rom into the CD Rom drive of your desktop or laptop computer. Make sure the connection between your computer and the PocketPC is properly established.

If the installation does not start automatically after the CD Rom was inserted, click Start on your Windows desktop and then Run. In that dialog box, use the “Browse” button and locate your CD Rom drive (e.g., D:\). On the CD Rom, select the file DATATRANS_SETUP.EXE. Then click “Open” and finally “Ok.” This launches the installation wizard which will guide you through the installation step by step. (Part of the installation wizard may be in German even when your version of DataTrans is in English; you can safely click “Next,” or “Weiter” – German for “Next” –, in every window.)

Follow the indications given on the screen. Installing the software is possible only when you accept the provisions contained in the license agreement. If during the installation process you are asked whether you want to install DataTrans in the standard application installation folder, we recommend that you answer Yes. If you answer No, you will be able to select another location, among others the PocketPC RAM. However, proper operation of DataTrans can only be guaranteed for installations of the software in the standard application folder.

To install Hürner DataTrans, you need so-called administrator privileges, i.e., full access to all system parts of your computer. This may not be the case if you use a computer that is part of a corporate network. If you have not set up your computer yourself, when in doubt, ask the person in charge of networking within your organization.

The installation is complete when your computer asks you to check on the mobile device if further steps are needed. With DataTrans, this is not the case.

If after the first installation of DataTrans on the PocketPC, you need to reinstall the program, simply insert the SD memory card into the PocketPC. A reinstallation may be needed, for instance, after the battery has completely discharged, which will have reinitialized the device to its initial setup per producer. In normal operation, the SD card works as a
backup memory. The DataTrans software and all welding reports stored in DataTrans are automatically backed up on the SD card. Thus, the program and all saved welding reports as well as the license data can be restored from the backup on the SD card.

It is possible to perform the first installation of DataTrans by simply inserting the SD card into the PocketPC. However, to ensure proper function of the DataTrans program features, it is preferable to install it from the desktop or laptop computer according to the steps indicated in this section.

During the DataTrans installation, a sub-folder DATATRANS is created under the ACTIVESYNC program folder on your computer. Do not delete this sub-folder nor the files it holds. They will be needed if you want to remove DataTrans from your PocketPC. This, too, is done from your desktop/laptop computer.

3.2 Starting DataTrans

After completing the installation, you will find DataTrans in the Programs sub-menu of the Start menu on your PocketPC. Start DataTrans by touching the program icon in the Programs sub-menu with the pointing stylus. After starting the program, you will see a screen similar to the one shown in Display 7.

3.3 Entering License Information

When you start DataTrans for the first time, no data on the licensee is displayed. You will have to enter the data on your software license in order to use all features of the program. To enter the license information, using the pointing stylus, touch the File menu and then the License option. In the dialog box that opens, you can enter the licensee name and the license key you were given when purchasing DataTrans. Place the cursor into the proper input field using the pointing stylus, then use the input tools of your PocketPC. Finally, confirm the input using the “Ok” button.

3.4 Input Tools of the PocketPC

The number and kind of features a PocketPC comes with, depends on the make and the manufacturer. Common input tools, however, are at a minimum a keyboard and a character analyzer. The way those tools work is rather similar in all makes. Refer also to the original documentation of your device.

For instance, the screen shown in Display 7 allows touching the keyboard icon in the lower right-hand corner, which will open a keyboard on the screen, on which you can enter one character after the other using the pointing stylus. When you touch the keyboard icon once more, the keyboard is masked again. The character analyzer of a PocketPC allows entering data by writing one character at a time on the screen of the PocketPC, which will then analyze the script and recognize the character. On Display 7, touching the small triangular arrow to the right of the keyboard icon will open a menu with all input tools available on the PocketPC. Most makes have an analogous menu.

4 Loading the Welding Reports from a Welding System

After starting DataTrans – provided the correct license information was entered (see Section 3.2) – you will see a screen similar to the one shown in Display 8. If there are no welding reports yet saved to PocketPC memory, the listing in the lower half of the screen is empty.
When reports are loaded from a welding system, every data transfer, i.e., all welding reports that are read from a Hürner Welding System in one go, are saved to one single file. This file is represented by one line in the listing on the PocketPC screen and is identified by its so-called “Id” (Identifier Number), by the type of welding machine or unit the reports were loaded from, by the number of that machine or unit, and by the date the reports were printed/transferred. This date is the date sent by the welding system as the current date. In case of error, the PocketPC will not correct any wrong date received from the welding system.

To load reports from a welding system, touch “Receive Data” using the pointing stylus. A screen similar to Display 9 will appear. Select the connection mode and the type of machine or unit from which the reports shall be loaded (not all units allow using a Bluetooth connection).

Confirm your selection with “Ok.” Then, Display 10 appears. At this point, prepare the welding system for printing/sending the data according to the indications given in Display 10.

4.1 Transfer via a Serial Interface

Using the Parallel/Serial adapter and the serial data transfer cable, connect the welding system to the PocketPC. If it does not show automatically, open the Print Menu in the welding system. Select the data you want to print/transfer (e.g., all commission numbers or individual commissions). Refer also to the User’s Manual of the welding system.

When the selection of the data to be printed is finished in the welding system, touch “Start reception” on the PocketPC using the pointing stylus, and press the START button of the welding system within 1 minute, to start the printing/transfer process.

The data that were transferred will be appended to the end of the listing as one single file identified by the next, incremented by 1 “Id” number. When it has finished loading the data, the PocketPC switches back to the overview listing (see Display 8).

4.2 Transfer via a Bluetooth Interface

Place the Parallel/Bluetooth adapter on the printer port of the welding system. If it does not show automatically, open the Print Menu in the welding system. Select the data you want to print/transfer (e.g., all commission numbers or individual commissions). Refer also to the User’s Manual of the welding system.

When the selection of the data to be printed is finished in the welding system, press the START button of the welding system to start the printing/transfer process. This will probably cause an error message to show on the welding system, telling you that the printer is not ready; but this is necessary to activate the Bluetooth connection. At this point, touch “Start reception” on the PocketPC using the pointing stylus, the error message disappears, and the printing/transfer process starts.

The data that were transferred will be appended to the end of the listing as one single file identified by the next, incremented by 1 “Id” number. When it has finished loading the data, the PocketPC switches back to the overview listing (see Display 8).

Make sure that the welding system is switched off and back on before every printing/transfer process. If you fail to do so, there is a risk for the transferred data to be corrupt or to contain errors.

Furthermore, note that between a serial and a Bluetooth inter-
face, the order of events, starting the transfer on the PocketPC, then on the welding system, is reversed.

5 Viewing Welding Reports on the PocketPC

If a line in the listing in the main window (Display 8) shows only the Id of a file, but no machine or unit type and number, a data transfer error or failure occurred. In most cases, these files cannot be displayed or processed. Contact after-sales service to delete the corrupt files.

To show a report file on the screen of the PocketPC, touch the Id of the file you want to view, using the pointing stylus. This causes the Id to be displayed on a blue background, which indicates that the file was selected. Then use the stylus to touch the **Show** option in the **File** menu (see Display 11).

This causes the reports in the file to be displayed on the screen (see Display 12). Using the scroll bars to the right and below, you can move through the displayed reports. There are four more buttons below the report view, above the “Ok” button; they allow browsing through the reports. From left to right, they perform the following functions: go to first page in that file – go to previous page – go to next page – go to last page in that file. In this situation, a page means a unit of display that is determined by the properties of the PocketPC. One such “DataTrans page” corresponds to 600 lines, where blank lines are also counted.

6 Transferring Welding Reports to DataWork GIS

6.1 Setting the Correct Connection Parameters

To be able to load welding reports from a Hürner Welding System or from a PocketPC running DataTrans into Hürner's Welding Data Management Software DataWork GIS, you have to set the correct parameters for the transfer connection first. Refer also to the DataWork GIS User’s Manual.

In DataWork, click the **Settings Transfer** option in the **Transfer** menu. In the dialog box that opens, select the interface port to which the PocketPC is connected; the example in Display 13 has a connection to the serial port COM1. To define the type of data source, select “DataTrans (PocketPC)” in DataWork GIS. (If you use the older edition, DataWork Version 1, select as the data type the welding system from which you want to load the reports, that is, for instance “HST300” or “CNC 2000.”)

As soon as you connect the PocketPC to your desktop or laptop computer, Microsoft’s ActiveSync utility will be activated on your computer (refer to Section 2.2 for ActiveSync). If both ActiveSync and DataWork attempt to use the same serial (COM) interface port, you will trigger an error message when you try to transfer data. To avoid this error, if it is not already open, open the ActiveSync main window by double-clicking on the green ActiveSync icon in the task bar (see Display 2). In the window, click the **Connection Settings** option in the **File** menu. A dialog box like the one shown in Display 14 opens.
In this dialog box, the option “Allow serial cable or infrared connection to this COM port” has to be adjusted to your situation. If your computer has several COM ports, you can select here a port for ActiveSync which is different from the one set in DataWork GIS. If your computer has only one COM port, you will have to fully disable this option (as shown in Display 14).

6.2 Selecting in DataTrans the Data to Be Transferred

In the main window of DataTrans (Display 8), touch the “Transfer Data” button. Then the screen will change to Display 15.

Select the DataWork version that is installed on your computer: DataWork 1 (the older version, without geo data capability) or DataWork 2 / GIS (the newer version that can handle geo data).

Then select the type of welding machine or welding unit that initially generated the reports you want to load from the PocketPC into DataWork or DataWork GIS. After you selected the proper version of DataWork and the proper machine or unit type, confirm with the “Ok” button. This brings you to Display 16.

Along with the listing of report files loaded from the selected unit or machine into the PocketPC (in the example in Display 16, from the HST300 Electrofusion Welding Units), a “How to” button is shown which allows you to view a brief instruction of how you can perform data transfer operations.

In the listing, select the report files that you want to transfer to DataWork or DataWork GIS. To do so, touch the respective Id numbers with the pointing stylus. The Id’s of all selected files are shown in the “Files” field in the lower part of the screen. If the field is not large enough to hold all applicable Id’s, the arrow buttons on both sides allow browsing backward and forward (see Display 17).

If you finally decide not to transfer a file that is already selected, and therefore want to delete it from the “Files” field, simply touch its Id a second time. This removes the Id from the “Files” field.
It may be helpful, in particular when you want to transfer a large number of files in one go, to type all Id's on the keyboard. To do so, place the cursor into the “Files” field and open the keyboard input tool (in the example in Display 18, by touching the keyboard icon). When typing the Id’s, separate them by commas. When you have finished entering the Id’s, close the keyboard tool (in the example, by touching the keyboard icon once more), so the “Start Transfer” button is visible again.

Info

If you want to transfer all report files shown in the listing, it is not necessary to select or to type each and every Id one at a time. Open the keyboard tool, place the cursor into the “Files” field, and type the Word “alle” (German for “all”) into this field.

Once you have selected all files you want to transfer, touch the “Start Transfer” button.

6.3 Starting the Transfer in DataWork and Finishing off the Transfer Operation

When you start the data transfer in DataTrans, within 1 minute you will have to start the data transfer in DataWork too. To do so, click the Start Transfer option in the Transfer menu. In the dialog box that opens you will first see an informative message and then, provided the PocketPC is connected and data transfer was started on it, a progress bar. As soon as all data have been transferred, DataTrans asks you to verify in DataWork if all data arrived successfully and to confirm by answering Yes if this is the case.

Immediately after this confirmation message, another message appears on the screen of the PocketPC. DataTrans asks you if you want to delete from the PocketPC memory the files that were just transferred. If you answer Yes at this confirmation message, the transferred files will be deleted irrevocably.

The delete confirmation message is also the item that finishes off the data transfer operation. The transferred welding reports can now be processed further in DataWork or DataWork GIS.

6.4 Direct Import from the PocketPC into DataWork GIS

DataWork GIS offers advanced functionality and allows importing welding reports directly from DataTrans/PocketPC into the welding database. This functionality is not available in DataWork, Version 1. Refer also to the DataWork GIS User’s Manual.

To use the advanced functionality in DataWork GIS, click the Import Database sub-menu in the File menu of the program, and select the option PocketPC, or click the corresponding icon in the DataWork icon bar. Provided the PocketPC is connected to your computer and Microsoft ActiveSync is active on your computer, all report files saved to DataTrans on the PocketPC are listed in DataWork (see Display 19).

In this dialog box, select the report files that you want to import into the current DataWork database (selected files can be recognized by the check mark in the box to the left of the file name), then click the “Import” button. This will append the reports in the selected files at the end of the currently open database.

Display 19
6.5 Deleting Reports in the PocketPC with DataWork GIS

The only possibility to delete report files in DataTrans is answering Yes at the delete confirmation message that pops up right after reports were transferred to DataWork (see Section 6.3). However, provided you use DataWork GIS, there is a possibility to delete welding report files that were saved to DataTrans on the PocketPC, using your desktop or laptop computer. DataWork, Version 1 does not offer this possibility.

In DataWork GIS, open the dialog box for the direct import of reports from DataTrans/PocketPC into the database (see Section 6.4 and Display 19). As you would do for the import of files, select the report files you want to delete, but then click on the “Delete Data” button.

DataTrans/PocketPC will complete the deletion of the files only after the PocketPC was restarted.

6.6 Restoring Reports Backed up on the SD Memory Card

All welding reports acquired from a welding system and saved by DataTrans are backed up automatically to the SD card, provided it was inserted into the PocketPC. If you have to restore reports that were lost, e.g., because of a reinitialization of the PocketPC, simply start the PocketPC and insert the SD card. This will reinstall the DataTrans software, if needed, will restore the reports that were backed up, and will load the license data from the backup, so you can use DataTrans right away without further delays.

7 Customizing DataTrans to Your Preferences

7.1 Display Language

You can choose the language in which DataTrans will appear on the screen of the PocketPC using the Language menu. Touch the menu title and then the language you wish to display the program in.

7.2 Program Version Information

The Program Info option in the Help menu displays information on the version number and the version release date of your DataTrans installation and also on your own software license.

7.3 Manufacturer Company

All contact data of the manufacturer are displayed when you use the Company Info option in the Help menu.

8 System Requirements

To use Hürner’s Data Transfer Software DataTrans for PocketPC, you will need a PocketPC (PAD) with the operating system Windows Mobile 2003 Second Edition or higher. Furthermore, the PocketPC requires a Bluetooth Stack from Widcomm.

Hürner DataTrans was successfully tested on the following devices:
Hewlett-Packard iPAQ H2210
Acer N30

In doubt, please contact our after-sales service.
9 Shipped Parts

- Hürner DataTrans installation CD Rom
- depending on your order, Parallel/Serial and/or Parallel/Bluetooth adapter
- data transfer cable (serial/USB)
- Secure Digital memory card
- PocketPC (optional)
CERTIFICATE
TÜV
MANAGEMENT SERVICE

The Certification Body of TÜV Management Service GmbH certifies that

HÜRNER Schweißtechnik GmbH
Nieder - Ohmener Str.
D-35325 Mücke

has established and applies a Quality Management System for

Development, sale and manufacture of welding devices used in pipeline construction applications, as well as the development and the manufacture of flow monitoring systems and engineering plastics

An audit was performed, Report No. 70005562
Proof has been furnished that the requirements according to

ISO 9001: 2000

are fulfilled. The certificate is valid until 2007-01-18
Certificate Registration No. 12 100 14555 TMS

Munich, 2004-01-28

Certification Body of TÜV Management Service GmbH
Unternehmensgruppe TÜV Süddeutschland
Rößlerstraße 65
D-80339 München

TGA-ZM-07-92